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1. Introduction

1.1 About CHILI Publisher and CHILI plugin

CHILI Publisher is a concept, developed by the CHILI publish bvba company. It offers its users the
possibility to edit their graphical artwork online.

The original idea of this concept involves these steps:

1. The graphical studio can create the Artwork template using a standard graphical editor.
2. The studio then sends the artwork in a specific format to the web-based CHILI Server.
3. The brand owners can check and edit the designs online.
4. The brand owners or their partners can directly generate the printable file.

The CHILI Server can be implemented to brand owners’ CMS as an integral part. It can be widely
customized to fit every possible need and constrain of the brand owner.

Until now only Adobe InDesign could be used to create the Artwork templates.

The CHILI plug-in adds an export capability of the design from Adobe Illustrator to CHILI Publisher.

However, CHILI plug-in goes beyond just exporting the templates for on-line editing: in combination
with Dynamic Content and Dynamic Art it offers a complete round-trip of the Artwork template and
the Copy content.

1.2 The general concept

1. The Graphical Studio creates the graphical concept.

The Studio at this point doesn’t have the actual text content for the artwork at that moment.
They use Dynamic Art to transform the dummy text objects into Dynamic Art placeholders. The
placeholders can be tagged with proper contextual information such as the Copy element type
and language variant code. In case there are multiple instances of the same Copy element type,
an instance ID (to make each element unique) is needed.

2. The Studio exports the artwork to the CHILI Package

The CHILI Package is the export format for the CHILI Publisher. This CHILI Package is then
uploaded the file to the Brand owner’s CHILI Server, an integral part of the Brand owner’s CMS
(e.g. ESKO WebCenter).

3. The Brand owner checks the file using the CHILI Editor

The Brand owner sees the Artwork template with the dummy text instead of the Artwork copy.

Besides the artwork, the editor provides a list of variables used in the Artwork template. The
Variables are originally the Dynamic Art placeholders and their names as defined in the first step.
This way, the brand owner knows exactly what to fill where.
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4. The brand owner fills in the Variables, and the Artwork template immediately displays the text
content changes.

This gives the brand owner an approximation of the final look.

5. When the Brand owner finishes the editing, the file is saved on the CHILI Server once again.

6. The Studio downloads the CHILI Package from the CHILI Server and imports the Package to
the original Artwork template file using the CHILI plug-in. The plug-in loads the text content into
the Dynamic Content, and the Dynamic Art placeholders are automatically filled by the new text
content.

1.3 The CHILI Package

The CHILI Package is the format used to send jobs from Adobe Illustrator (using the CHILI Plug-in)
to the CHILI Server and Editor, and vice versa.

The CHILI Package contains

• the XML file(s) in a specific format, describing the exported artwork
• the resources – fonts and images.

In the current version of the CHILI plug-in, artwork objects other than text objects are rasterized to
PNG files.

The fonts used in text objects can be exported as well. Since the CHILI Server stores the font files in
its repository, you can save some time by exporting and uploading new minor versions of the same
artwork without (resending) the font files.

Note:  Not all font types are supported by the CHILI Server (see also Known Limitations on page
13). Text using unsupported fonts cannot be displayed correctly by the CHILI Editor. When
exporting an artwork using unsupported font you will get a warning. You can however still generate
the package and open it in Editor.

The Package, downloaded from the Server, uses the same format and includes all changes made on
the Server. The XML data content contain the styling tags, describing the styling made by the CHILI
Editor. Those tags can be optionally used by the Style mapping feature of Dynamic Content.

Note:  The XML data use the GS1 XML standard format. This implies the plug-in can only cooperate
with Dynamic Content version 12.1 or higher.
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2. Bar codes

In the Preferences for the CHILI plug-in you can define how to handle bar codes:

• You can export any supported bar code created by the Dynamic Barcodes plug-in, allowing its
value to be edited in CHILI Publisher, but without getting a live preview there

• You can export EAN 13 bar codes, allowing its value to be edited in CHILI Publisher, and you will
get a live preview of the result

• You can export bar codes as static images.

Check digit and valid input

While entering the bar code data value in the CHILI Editor, the input is not checked for the correct
check digit. This means a user can enter an invalid value in the variable field, and will get no warning
from the server. The bar code is created with the correct check digit due to the internal self-checking
ability of the barcode module on the Server.

Entering invalid data creates an inconsistency between the barcode variable value and the visual
barcode interpretation in the CHILI Editor. The CHILI Package downloaded from the Server and
loaded to the CHILI Plugin will contain this invalid value. Because of this, the barcode won’t be
updated, so it’s strongly recommended to check the barcode values while entering them in the CHILI
Editor.

2.1 Export bar codes as images linked with CHILI
variables

When using this way of exporting bar codes, the bar code is exported as an image, coupled with
a CHILI variable.

The variable can then be edited on the server, but the image remains unchanged, and only works
as a placeholder.

The changed variable goes back with the downloaded CHILI package, and can be applied to the
artwork by the Dynamic Bar Codes plug-in when linking the XML.

2.2 Export bar codes dynamically

If your job contains an EAN 13 barcode, this barcode can be displayed and edited by the CHILI Editor
with a live preview. Other barcode types are currently not supported. Setting up the environment for
the live preview needs setting up both the station and the CHILI server.

2.2.1 Bar code definitions

To work with bar codes, the following conditions must be met:
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1. the bar code type should be defined in advance on the CHILI Server.
2. the corresponding bar code definition should be in the barcodes.xml file in the plug-in
3. the bar code in the graphic design should match the bar code definition.

On the server:

The bar code definition on the server contains the barcode type, but also the barcode parameters
as height, all four directions of the quiet zone (box) and the human readable text position.

Because of this, each variation of the barcode has to be pre-defined on the server. For example,
“EAN 13, No text, 25.93 mm height, no box” has to be one definition, “EAN 13, Text below, 10 mm
height, 1-1-1-1mm box” another one.

Each bar code definition has its own unique internal ID which is used for identification. In a
CHILI Package, only the ID is included, and the barcode type and its technical parameters are not
transferred along. The whole process relies on the pre-defined barcode set.

On the server in the Barcode Types section, there is an Info tab, where the Object XML part contains
necessary information. Here is a sample of the definition tag:

<item name="EAN 13, 25.93mm, Below" id="d4ef11b4-1ca1-49e9-
ad99-4febfa4d34c0" relativePath="" type="ean13" bottomQuietZone="0 mm"
 topQuietZone="0 mm" height="25.93 mm" textLocation="belowembedded"
 leftQuietZone="0 mm" rightQuietZone="0 mm"/>

This snippet can be copied and pasted to the barcodes.xml file

The plug-in:

On the plug-in’s side, the bar code definition should be in the configuration XML file “barcodes.xml”,
located within the plug-in’s bundle package <Ai app folder>/Esko/CHILIPlugin.plugin.
This file should contain bar code definitions matching those defined on the server.

In the graphic design:

If a bar code in the artwork matches (both bar code type and parameters) with one of those
in “barcodes.xml”, the ID stored there will be included in the package, and that barcode will be
displayed by the CHILI Editor.

Note:  If the barcodes.xml file contains more than one identical definition (so the same bar code type
and parameters, but with different ID, for example coming from another server or server environment),
the ID of the first one of them will be used while generating the package.

2.2.2 Bar code parameters

The barcode parameters Type, Human readable text, Height and Box (quiet zone) are pre-defined
on the server side and have to match the parameters set by the Dynamic Barcodes plug-in, see Bar
code definitions on page 5. When setting a bar code in Adobe Illustrator, these are the things
you have to keep in mind:

Magnification

When checking if a bar code matches one of the bar code definitions, the height before applying
the Magnification factor is used.

For example:
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1. The CHILI Server contains a bar code definition for a default EAN 13 barcode with a height of
25.93 mm

2. The graphic design contains a default EAN 13 bar code with a height of 25.93 mm that matches
all other parameters as well

3. The graphic design also contains a copy of this bar code, but with magnification factor changed
to 80%. The height is changed automatically by the Dynamic Barcodes plug-in to 20,744 mm.

Both barcodes, despite having a different height, will match the same definition on the server.

Note:  As the CHILI editor doesn’t understand the Magnification parameter, both barcodes will be
displayed in the same size at 100% magnification.

Background

The CHILI Editor can’t manage bar codes without a background, i.e. with Box parameter in Dynamic
Barcodes set to off. In that case the barcode will be generated as if Box is set to 0 on both sides.
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3. Export to CHILI

1. Set up the placeholders for CHILI. See Preparing the Artwork template for CHILI export on page
8

2. Export the file to CHILI. You have different options:

• Export to CHILI using WebCenter Connector on page 8
• Update the CHILI package on WebCenter using WebCenter Connector
• Export to CHILI Package on page 9

3.1 Preparing the Artwork template for CHILI export

Before you can start preparing the artwork for export to CHILI, you need to ensure that the CHILI
options are enabled in the Dynamic Art Preferences:  Illustrator > Preferences > Esko > Dynamic
Art Preferences > .

1. Select the text object(s) you want to be editable by CHILI

2. In the Dynamic Art palette, add these objects as new Dynamic Art

3. In the Dynamic Art palette, double-click the objects to open the Dynamic Art Options palette

4. In the CHILI Publisher settings, you can predefine the CHILI variable type

• Default: the default setting from the Preferences will be used
• Single Line: the variable entry in CHILI is limited to one single line. Using the Maximum

number of characters you can even limit the entry to a certain number of characters, e.g.
to limit the size of a headline.

• Multiline: the variable entry in CHILI allows multiple lines. Using the Maximum number of
characters you can limit the entry to a certain number of characters.

• Formatted text: this variable will keep the source formatting when displayed in CHILI. You
can set if you want to allow changing the font, underlinement, strikethrough and superscript
or subscript. The formatting changes done in CHILI will be transferred back using the Style
Mapping feature of Dynamic Content.

• List: the possible entries for the variable will be limited to the ones listed in "List Values".

Note:  The CHILI variables are connected with the XML attributes set on the left side of the
Dynamic Art Options palette. Changing the XML attributes might change the CHILI variable type.

3.2 Export to CHILI using WebCenter Connector

The WebCenter Connector plug-in allows to export and upload the Artwork template to Esko
WebCenter in a single step. If WebCenter is running the CHILI Publisher back-end, it's also possible
to edit the text content directly in the WebCenter environment.

To upload the Artwork template to WebCenter:
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1. Select  File > WebCenter > Export > CHILI Package...

2. Review and set the Export to CHILI options and Layer Options. See Export to CHILI options on
page 9 and Layer Options on page 10

3. If necessary, log into WebCenter

4. Select the Project you want to upload the document to, and click Export

For further information on the WebCenter Connector, we refer to the WebCenter Connector
documentation

3.3 Export to CHILI Package

To export the Artwork template to the CHILI package file:

1. Select  File > Export

2. Set the Format to CHILI Publisher package (chp)

3. Select the output folder, and click Export

4. Review and set the Export to CHILI options and Layer Options. See Export to CHILI options on
page 9 and Layer Options on page 10

5. Click OK

The resulting CHILI package file can then manually be uploaded to WebCenter or to any other CHILI
server

3.4 Export to CHILI options

Font embedding

The Package holds information about fonts, used by the text objects. The Embed Used Font
Families option includes not only the actually used font types, but the whole font families. This
allows the CHILI Editor to use for example the "Semibold" variant of the font that was originally only
used in the "Bold" variant. Embed Used Font Faces Only stores only the really used font faces in
the package. You can also select Do Not Embed.

Note:  If the Package doesn’t contain the used fonts, and the fonts are not available on the server,
either because they have never been uploaded before, or because they are stored in a different
asset folder (see below), CHILI won’t load the package.

Text Rasterization

If a static text object (i.e. what will not be exported as a CHILI variable) within the artwork uses styling
not supported by CHILI Publisher, it's possible to choose how to export it. Rasterize if Having
Unsupported Style will keep the objects with supported styling as texts and the rest is rasterized
to keep the appearance. Always Rasterize rasterizes all text objects, and Do Not Rasterize keeps
all text objects as a text, even though it might result in a different appearance when displayed by
CHILI Publisher.

Rasterization Resolution
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The export operation generates images from static art. The images representing these objects, will
be exported using the resolution set here. The image quality has an effect on the appearance of
the artwork displayed on CHILI Publisher.

Note:  The settings on the CHILI Server may override this option.

Default Variable Type

Defines the CHILI variable type, which will be used if the CHILI variable type in the Dynamic Art
Options dialog is set to Default.

• Unformatted Text: the CHILI Editor cannot modify the formatting of the variable.

• Formatted Text: the CHILI Editor can modify the formatting of the variable.

• Formatted Text if Having Unsupported Style: the plug-in will automatically decide whether
the text objects is uniform (one text style for the complete object) or uses various formatting
(e.g. different font, size, in the same text object). In this case, it will not be possible to format
uniform objects in the CHILI Editor.

Review Variables for Export

Clicking this button opens a list of CHILI variables used in the artwork. You can review the variable
names and types there and also issues detected during the export related to CHILI variables. You
can save the variable list to the structured text file, so the variable names can be used to set up
the WebCenter environment later.

3.5 Layer Options

The Layer Options can be opened from within the Export to CHILI options dialog, or by choosing
Window > Esko > Dynamic Art > CHILI Layer Options...
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For every Layer in your Illustrator job, you can define the Display Name and the Visibility.

TheDisplay Name is the name that will be used for the layer in the CHILI Editor. By default the name
of the Illustrator layer is used.

The Visibility can be set to

• Fixed - the layer is always visible

• Optional - the user can make the layer invisible by checking the checkbox in CHILI user interface

• You can make one or more groups. Each group will be represented by the drop-down menu, so
only one of the layers can be visible in CHILI

The layer visibility, set in CHILI, will be applied on the actual document as soon as the CHILI document
is loaded back to the Dynamic Content plug-in. The update of a CHILI document may automatically
change the layer's visibility in Illustrator, according to the actual state set in CHILI.
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4. Link a CHILI document

4.1 Link the CHILI document from WebCenter Connector

Variables in an artwork template, uploaded on WebCenter, can be edited in CHILI editor.

To get the edited data back from WebCenter, you can link the CHILI document to the Dynamic
Content plug-in similar to linking standard XML files. To get the CHILI document to Dynamic Content:

1. In the Dynamic Content fly-out menu, select Add XML from WebCenter...

2. In the WebCenter Connector, browse for the project, and select the CHILI Package you want to
link.

3. Click Open

The Dynamic Content plugin will show the selected file. If there are matching elements in the loaded
document and the Artwork template, you will have the option to proceed with Auto link.

The CHILI Document now behaves as any other linked XML. See the Dynamic Content
documentation for more information.

4.2 Link the XML from a CHILI package

Variables in an artwork template, uploaded on WebCenter or CHILI, can be edited in CHILI editor.

You can manually download the CHILI Document, and store it as a .chp file. You can link this file to
the Dynamic Content plug-in similar to linking standard XML files. To get the CHILI document (.chp)
to Dynamic Content:

1. Select  Window > Esko > Dynamic Content > Dynamic Content  to open the Dynamic Content
palette

2. In the fly-out menu of the Dynamic Content palette, select Add CHILI document.... If no XML file
is currently selected, you can also click Add CHILI document in the middle of the (empty) palette.

3. Browse for the CHILI Package you want to link.

4. Click Open

The Dynamic Content plugin will show the selected file. If there are matching elements in the loaded
document and the Artwork template, you will have the option to proceed with Auto link.

The CHILI Document now behaves as any other linked XML. See the Dynamic Content
documentation for more information.
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5. Known Limitations

Although CHILI Editor can display very well various artworks, there are still some limitations
and incompatibilities. CHILI plug-in analyzes the artwork while export and raises warnings when
necessary.

According to the concept, non-supporting of following features doesn’t prevent (in most cases)
exporting the artwork and doesn’t harm the artwork itself. It makes a visual difference in the
appearance of text objects in the CHILI Editor only. The CHILI Package will be used just for transport
new data content to the original artwork via Dynamic Content.

Limitations in CHILI Publisher version 3.5:

• Only TTF and OTF fonts are supported. CHILI does not support Mac data-fork font files (.dfont),
TrueType Collections and PostScript fonts. However, CHILI Publisher plug-in converts collections
to regular font files if possible.

• CHILI supports Lab color space but spot colors must be defined using CMYK

• Character scaling; it also affects text object’s transformations except rotation. Support for the
uniform horizontal scaling of the whole text box is currently implemented

• Vertical text is not supported natively, but is simulated by the CHILI Plugin

• Per-character stroke and blend mode is not supported in the Flash rendering engine on server’s
side. However, support for uniform per-character features is under development on the plug-
in’s side. It means that if the text box uses the same features’ set on all characters, the export
procedure could manage to modify the object’s parameters to correctly visualize these features
in the Editor.

• Gradient fills on frames is supported, but not individual characters

• OpenType features: Digit styles (lining/old-style, proportional/tabular) are unofficially supported;
other features (ligatures, fractions, ordinals) are not.

• Strikethrough: Illustrator positions strikethrough at the half of thex-height, while CHILI uses the
middle of the em-box.

• Overprint attribute is not supported by the CHILI Editor; CHILI plugin simulates it by the Multiply
blend mode.

• Barcodes have to be defined in advance on the server, and the barcodes created for a certain
server are not recognized by another. If the package contains two barcodes, the color change of
one of them in the CHILI editor applies also on the second one. See also Bar codes on page 5

CHILI Editor doesn’t support following Illustrator’s features (CHILI Publisher version 3.5):

• Small caps
• Automatic hyphenation
• Pattern fills
• Multiple fills
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• Color Burn blend mode
• Color Dodge blend mode
• Soft Light blend mode
• Exclusion blend mode
• Hue blend mode
• Saturation blend mode
• Color blend mode
• Luminosity blend mode
• Difference blend mode
• Overlay blend mode
• Hard Light blend mode
• Lighten blend mode
• Screen blend mode

Know issues on the CHILI Server side related to the CHILI plugin:

• Text variables: bad alignment of the last paragraph line: If a paragraph is aligned to block (with
the last line to be aligned to the left), the last line will be stretched over the full frame width

• Formatted text variables: bad propagation of the text's formatting into the frame. Incorrect
implementation of the inheritance of styles in nested tags.

• Inability to specify the background color of the editor fields for formatted variables - the white
text is not legible on the white background
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6. Preferences

The Preferences can be opened by selecting  Illustrator > Preferences > Esko > CHILI Plug-in
Preferences  (Mac) or  Edit > Preferences > Esko > CHILI Plug-in Preferences  (Windows).

6.1 General Preferences

The General preferences configure the level of user awareness of events happening during the export
to the CHILI Package.

You can enable or disable logging to the Messages dialog, or make the output verbose, i.e. write
every message generated by the export.

By default, warnings are listed in the Messages, and exporting continues. However, if you enable
Stop on Warnings, exporting will stop.

Further logging you can find in the Diagnostic console.

By clicking the Reset Hidden Dialogs button, all messages in the CHILI Publish plug-in where the
option "Don't show this again" has been selected, will be switched on again.

6.2 Export Preferences
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The settings you make in the Preferences are used as defaults during further processing

Font embedding

The Package holds information about fonts, used by the text objects. The Embed Used Font
Families option includes not only the actually used font types, but the whole font families. This
allows the CHILI Editor to use for example the "Semibold" variant of the font that was originally only
used in the "Bold" variant. Embed Used Font Faces Only stores only the really used font faces in
the package. You can also select Do Not Embed.

Note:  If the Package doesn’t contain the used fonts, and the fonts are not available on the server,
either because they have never been uploaded before, or because they are stored in a different
asset folder (see below), CHILI won’t load the package.

Text Rasterization

If a static text object (i.e. what will not be exported as a CHILI variable) within the artwork uses styling
not supported by CHILI Publisher, it's possible to choose how to export it. Rasterize if Having
Unsupported Style will keep the objects with supported styling as texts and the rest is rasterized
to keep the appearance. Always Rasterize rasterizes all text objects, and Do Not Rasterize keeps
all text objects as a text, even though it might result in a different appearance when displayed by
CHILI Publisher.

Rasterization Resolution

The export operation generates images from static art. The images representing these objects, will
be exported using the resolution set here. The image quality has an effect on the appearance of
the artwork displayed on CHILI Publisher.

Note:  The settings on the CHILI Server may override this option.

Default Variable Type

Defines the CHILI variable type, which will be used if the CHILI variable type in the Dynamic Art
Options dialog is set to Default.

• Unformatted Text: the CHILI Editor cannot modify the formatting of the variable.

• Formatted Text: the CHILI Editor can modify the formatting of the variable.

• Formatted Text if Having Unsupported Style: the plug-in will automatically decide whether
the text objects is uniform (one text style for the complete object) or uses various formatting
(e.g. different font, size, in the same text object). In this case, it will not be possible to format
uniform objects in the CHILI Editor.

Restrict Editing of Live Art

This option can be used in special cases when it's handy to export all non-rasterized text objects
with an unlocked status in terms of CHILI. It allows to directly manipulate the objects in the CHILI
admin mode when creating customized CHILI templates.

• Lock Position and Contents (default) - all objects are exported as locked.

• Lock Content - all objects are exported so they can be moved around, but it doesn't allow
editing the content.

• Lock Position - all objects are exported so they allow editing of their content, but it doesn't
allow changing the position.
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• Do Not Restrict - all objects are exported as unlocked, so an administrator can edit their content
and move them.

Restrict Editing of Static Art

This option can be used in special cases when it's handy to export all rasterized objects with an
unlocked status in terms of CHILI. It allows to directly manipulate the objects in the CHILI admin
mode when creating customized CHILI templates.

• Lock Position and Contents (default) - all objects are exported as locked.

• Lock Content - all objects are exported so they can be moved around, but it doesn't allow
editing the content.

• Lock Position - all objects are exported so they allow editing of their content, but it doesn't
allow changing the position.

• Do Not Restrict - all objects are exported as unlocked, so an administrator can edit their content
and move them.

Export Barcode Placeholders

Barcodes can be exported in various ways:

• As Static Art - all Dynamic Barcodes will be exported as static images.

• As Static Art With Variables - all Dynamic Barcodes will be exported as images followed by
the CHILI variable

• As Live Barcodes (EAN only) - EAN 13 barcodes can be exported to be fully dynamic on CHILI
Publisher. For details of the settings see Export bar codes dynamically on page 5

Include all document swatches

This option adds information about all Swatches present in the document to the Package. This
information can be used on the CHILI Server side.

Include all document text styles

This option adds information about all named text styles present in the document to the Package.
This information can be used on the CHILI Server side.

Default Assets Location

You can define the name for the resource folder on the CHILI server. The Package holds this
information and CHILI server takes exported Static Art images from the Package and stores
them into that folder. If the folders don’t exist yet, they are created first. The default value is
“AICHILIPlugin”.

Default Fonts Location

You can define the name for the font resource folder on the CHILI server. The Package holds this
information and CHILI server takes the bundled font files from the Package and puts them to that
folder. If the folders don’t exist yet, they are created first. The default value is “AICHILIPlugin”

6.3 Webcenter Connection Preferences

The WebCenter Connection Preferences are only available if you have the WebCenter Connector
installed.
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Automatically link the uploaded document to Dynamic Content

When the document is exported to CHILI package and uploaded to WebCenter using the
WebCenter Connector, according to this option the package on WebCenter can be also immediately
loaded back to Dynamic Content. Uniquely identified placeholders will then be linked automatically
with the package variables.

Automatically check for new document version every

Sets the timer for automatic status checking of CHILI packages in Dynamic Content, linked from
WebCenter.

Download Linked Document As

The package data can be obtained from the CHILI server as a Document XML Only or as a Full
CHILI Package. As Dynamic Content uses only the data portion of the CHILI package, using full
CHILI package serves mainly for debug reasons.
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